
Cosmin Saveanu -- Thursday 4th May 2006
-----------------------------------------------------------

Participants : Cosmin, Melissa, Olivier, Catherine

[Catherine introduces the aim of the interview]

Cosmin : The main problem we had was solved by Marc Vincent plugin (Extend). Without this plugin, that we use all the time, 
Cytoscape would be unusable. It is not really possible to explore networks. Well you can, but you have to use other plugins, so 
you have to learn them, and they do not exactly do what you need, and they sometimes fail while trying to connect to the 
Internet...
[Cosmin opens the Plugins menu and select the 3rd item (not legible on the video)]
I never use it. Maybe I would use it if we did not had Extend.

Catherine : apart form this, what problem did you have?

Cosmin: yes, there is something very annoying. 
[Cosmin starts with a single node network by entering a gene name in a popup window - figure 1]

  
Figure 1

[he then uses the contextual menu to use the Extend plugin to get the neighbors - figure 2 and 3]

 
Figure 2

Figure 3

[and then choose a layout in the Cytoscape menu]

Cosmin : this is a physical (in green) and I think genetical (in pink) interactions network. In blue it's some other kind of 
interaction, and in black, physical, but of another type. 

[Cosmin hesitates while describing the interaction types associated to color, and uses contextual menus on edges to find the 
information - figure 4]



Figure 4

Cosmin : one of the difficulties with colors is that I did not know where colors are kept. I found that it was a preferences file in "/
Library/.... etc" and then I found out that is was possible to specify where to put the preferences file. I'm now using a folder in my 
own directories.

Catherine : why did you need to know?

Cosmin: this is very important when you want to keep colors when moving Cytoscape. To have all those colors, you have to do 
some work! Marc's plugin was also very important for this, to have different colors for different types of interactions. I can show 
you that.

[Cosmin opens a menu giving - apparently - access to Extend features, and selects "Extend properties" - figure 5]

Figure 5



Figure 6

Figure 7

Cosmin : the interface is not very easy to follow, but, was it does is to group many interactions types. Many... all these 
interaction are of 2-hybrid type and they come from different PubMed id numbers (figure 8). You would not need to group them 
if you had a few types, but we have 300 types of interactions, and it's difficult to map colors to so many types.



Figure 8

Cosmin: I will show you what does it mean when you define colors [Cosmin opens the Visual type window - figure 9]

Figure 9

Cosmin: if I have the group, it's easy [shows the mapping between 2h and green]
I I'm using what's by default ... [figure 10 shows that the default is "interaction", while "Extend Group name" was checked"]

Figure 10

Cosmin : ... I hope it will work... [the user interface is freezed while loading all the interactions types - figure 11] 



Figure 11

Catherine : did you introduce the concept of groups?

Cosmin: it was Marc.

Catherine: I guess you had to modify the "Set Visual Style" window?

Cosmin: no because he did a very wise trick. It was to use attributes for the groups. Each of these types of interaction has an 
attribute for the group. So you just use the internal searcher of Cytoscape. This one of the most important improvement of the 
visual interface that Marc's plugin enabled. And it's really, really important... for our work I mean.

Catherine : but... why is it so that you needed to introduce so many interactions?

Cosmin: there are many types of interactions in the literature. You have hundreds and thousands of ... [patterns of interaction?]. 
I mean.. it's quite important to be able to say from the graph that this interaction was found in that paper and the other in 
another paper. "Interaction type" is probably not the correct name. But this is important [looking for some annotations put on 
edges and then fetching the PubMed web page - figure 12] because we know where this interaction comes from.

Figure 12

Catherine : so it's important to be able to visualize this from the graph.

Cosmin: you could use edge attributes instead, but it's more complicated.

Melissa : I see that there is also something to set the node properties? Some nodes have a green circle...

Cosmin: this is also Marc's plugin. If there are other interactions that are not visualized, the node color changes. For instance... 
[Cosmin looks for a node that has not too many additional interactions... and selects one -- figure 13-16]
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Figure 16

Cosmin: so now it no more any gree circle. We discuss improvements with Marc: you could have a number showing the 
number of interactions, or you could have different widths. The thickness of the circle could indicate the number of interactions. 
Because Cytoscape is very very flexible, you could map the number of interactions to this attribute. But.. this is already quite 
good.

Catherine: what would you think of a local fish-eye view of this information?

Cosmin: ... I... I don't know. I thought it could be interesting to look at very large networks... this is in fact already a quite large 
network  Over that, you were unable to see anything that would be useful for what we are doing.

Catherine: it would be just something more informative than the thickness of the circle? You click on a node, a small fish-eye 
view is displayed...

Cosmin: oh.. to see how many interactions... ok. It could be interesting, but...

Melissa: since Marc made this nice plugin, I want to see what it exactly does.

Cosmin: you select a protein and then ask for the neighbors. The plugin can be a problem for other features of Cytoscape. For 
example, when using GO annotations, normally Cytoscape will show you only the annotations for the nodes that are present in 
the network.. But since a large table is in memory due to the plugin, we get the list of all GO annotations. So we cannot use it 
anymore when we use the plugin. But we can isolate and save this network somewhere and reload it from a file, and then use 
GO.
 
Catherine : [going back to the annoying aspect of defining colors for interaction types, and the idea of groups]

Cosmin: yes the idea of groups could be separate from Marc's plugin. We could also improve Marc's plugin, it's not obvious to 



use!

Catherine: do you use filters?

Cosmin: no.

Catherine: Have you tried to and failed?

Cosmin: it's really difficult. Once you see the examples, I have seen some examples... so it can of works (laugh)! Sometimes I 
use them when I want to select nodes that begin by... for example, nodes that begin with... In some networks we have many 
ribosomal proteins that we don't know if they are genuine or artefactual. So we would like to select ribosomal proteins. Since 
all their name begin with RPL or RPS, this is possible. I'm using that from time to time.

Catherine: can you show a case where it did not work?

Cosmin: [opening the Filters menu and trying the RPL* filter - figure 17]
Nothing! BTW it would be interesting to have a message telling that nothing was found.

Figure 17

Cosmin: I tried some topological filters, but ... I wanted to remove everything that had more that 15 interactions for example. 
Nodes that have too many, usually they are not ... they are artefactual.

Catherine: can you try again?

Cosmin: [selects the topological filter and tries to enter a constraint such as: > 10 in the neighbor field  and then selects and 
item 1 in the "that pass the ... filter" menu - figure 18]

Figure 18

Cosmin: [applying the filter and seeing that nothing was filtered in the graph] This is not normal, ... ah but this is also probably 
the plugin's fault, because what we see here is only part of the network.
[Cosmin also sees that the filter menu has changed his >10 to 1]
I don't  understand why it's now 1? Apparently it does not work.

Melissa: what would happen if you tried the specific number (instead of >) ?

Cosmin: yes, probably [Cosmin tries 10 but again, no filtering seems to occur]

Catherine: what's the last line : "that pass the __ filter" ?

Cosmin: yes, this is very annoying. I don't know why, you have to combine the filter with some other filter.

Catherine: can't you just remove this constraint or... ?

Cosmin: [looking at the menu again] No... I really think this interface should be completely changed! 



Catherine: so it's like you have to combine..

Cosmin: That's why I have this canonical name like everything because in yeast every name starts with Y* - figure 19

Figure 19

Cosmin: that's why I was really disappointed - maybe it would be useful if it worked.

Catherine: it would be useful, because it's a way make the network more clear

Cosmin: I agree! and to see easily [?] . Unable for the moment.

Catherine: have you tried to filter according to the function?

Cosmin: [hesitating] No.  What interested me was the topology filter. I remember that somehow it worked, but I don't remember 
how.

[pause]

Cosmin: I remember that in Cytoscape 2.2, you can create nodes? I found found the interface less easy to use that the one that 
Marc developed. What we can do here - let's start another network (figure 20-22)

Figure 20

Figure 21



Figure 22

Catherine: do you mean that Marc also made a visual editor?

Cosmin: yes, and it's very good.

[Cosmin then enters a new node by entering a node name - like in figure 21 -- figure 23]

Figure 23

Cosmin: and the you can say .. I want an edge [Cosmin opens the plugin menu again and selects "new edge" - figure 24]

Figure 24

[a dialog box prompts for the type of the interaction - figure 25]

Figure 25

[Cosmin looks for an item in the list of interaction types, but then enters a label]

Cosmin: so you have it (figure 26).



Figure 26

Cosmin: what's really good is that you can also use the extend functionality (figure 27, see result in figure 28).

Figure 27

Figure 28

Melissa: wouh!

Cosmin:  yes... this is a highly connected network!

Catherine: so you can edit the network without being in an editing mode? It's direct?

Cosmin: yes. So.. I found it easy to do. It's intuitive, it's what you would do normally. [looking for the Cytoscape editor] I don't 
remeber exactly how you do this with Cytoscape? [Cosmin is browsing all the menus from left to right and back again, not 
finding the editor]

Cosmin: [I just saw the "Squiggle" item in the Edit menu] Squiggle is very nice, you should extend it. (figure 29)



Figure 29

Melissa: how do you use it?

Cosmin: I know nodes that are important. The only problem is that is free drawing, it's ugly. If we could do circles or rectangles. 
That would be better to present.

Catherine: Can you save it?

Cosmin: no, that's one of the problem, but you can print it I think.

[still looking for the editor...]

Melissa: .. under the file menu

[Cosmin selects the default editor and creates a new node - figure 30]

Figure 30

Cosmin: and then... so it's not integrated in my network [he looks for the menu - figure 31]

Figure 31

Catherine: you can connect it

[Cosmin drags the rectangle for the edge over the node twice and then gets the edge displayed -- figure 32]

  
Figure 32

Cosmin: how do I change the name - it's called node0... it's not integrated in my network. the node that I created with Marc's 
plugin was a node that had a name, a gene.

Catherine: but you can change it?

Cosmin: I don't know how? I would be happy to. How do you do that? [he again looks at the node's contextual menu]

Catherine: you never change the name of a node?

Cosmin: maybe... [Cosmin looks at the attributes window and finds the attributes menu - figure 33]



Figure 33

Cosmin: oh! [the canonical name column is now displayed, so he can enter the name - figure 34]

Figure 34

[the name in the graph is still unchanged]

Cosmin: I know why, it has to be the common name. I don't know why it does not map the common name... It has the canonical 
name, normally it should be able to do that?

Catherine: and if you change the common name?

[Cosmin changes it]

Cosmin: it still is not integrated in my network.

Catherine: what do you mean?

Cosmin: I cannot explore the network. [Cosmin then creates a new node with the same name with the plugin]

Cosmin: where is it now? [the new node is difficult to locate] 

Melissa: down there?

Cosmin: It's already in the graph and linked  [Cosmin drags the node below the graph - figure 35]



Figure 35

Catherine: why is that? what do you have for information in this node to integrate it in the graph?

Cosmin: I don't know! But it works!

Melissa: maybe Marc's plugin has the knowledge of nodes added by its editor.

Cosmin: yes, it's probably not the same namespace... [for nodes added by Cytoscape editor I guess]

Cosmin: you can use whatever name you want, The only problem is that they won't be useful. I mean, you cannot start a 
network with a name that is not present in the table we use. But you can do it, if you want to sketch a small network.

Melissa: So, how do you use Cytoscape? How do you use this node? What's you next step?

Cosmin: So.. first .. I show you what we do usually. (I want to get rid of cytopanel 1...). what is also nice is that you can start a 
network with several nodes. [meanwhile Cosmin enters names in the "Start with?" dialog box - figure 36]

Figure 36

Catherine: what do you mean by "start" ?

Cosmin: yes, that's a concept! You have to start somewhere.

Catherine: you mean to start the display.

Cosmin: So for example, in a experiment you identify 2 or 3 proteins that are probably linked to each other... So I have 3 
proteins, I know there are interactions around.

Catherine: does it create a subnetwork?

Cosmin: yes (figure 37)



Figure 37

Catherine: so it's like a filter?

Cosmin: yes... but it works!

[laughs]

Cosmin; you can also extend the network from the 3 nodes [Cosmin selects the appropriate item in the plugin menu - a dialog 
box warns about the numbers of interactions that is quite big - figure 38]

Figure 38

Cosmin: I will not do it [he then only extends one of the node from the contextual menu ; he also changes the layout] 

Cosmin: so if for example I had the 3 proteins coming from the same experiment, now I can see that 2 of them are highly 
connected so it's this one (figure 39) ...

Figure 39

... and .. I lost the other one - this one (figure 40) [he drags the node to the right]

Figure 40

... these 2 are connected, and there are connections I can find out in the publication (on the Web - figure 42)
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Figure 42

... it's a good one, I'm quite confident. There is another one, it was in press so we had no PubMed ID. I know it's a good paper 
too. then we can look for other interactions around.

Catherine: how do you know there are many interactions? [there are only 2 arrows between the 2 proteins]

Cosmin: the quality is important, not only the quantity. This one for example, I can remove it.

Catherine: how do you see the quality?

Cosmin: from the colors. Green is 2-hybrid; if you only have one, it's probably not true.

Melissa: are there some edges that are thicker than others?

Cosmin: we also map some methods that we know are more sure - these ones are thicker. The ones that are not.. where we 
have doubts are like that (figure 43)...



Figure 43

... we have doubts but it still a good study so... It's very important to be able to know how confident we can be, just looking...

Catherine: and did you set this manually? The quality of each edge?

Cosmin: yes. That's the idea of the groups. You create your 6 or 7 types of groups. What's nice in Cytoscape is that you can 
map the color, thickness, ... on different grounds. In this case, the color is based on the group, and the thickness is based on 
the exact type of interaction, because we only needed to do it for some specific papers.

Catherine: [back to the question of quantity/quality]

Cosmin: if this case [ he puts the pointer on the bottom left] it's good too - we have 2 colors (green and....).

Melissa : so you can also select that... you want to remove nodes from the display?

Cosmin: the only problem is that they will come back when you do something else with the network! [Cosmin removes a few 
nodes from the graph by selecting them and clicking on the  "Hide selected" button...]  I'm cleaning up the network. Yes of 
course, the topology filter would be very useful. For example, I want all the nodes that have (only?) 1 interaction of the type 2-
hybrid.- and then I could hide them all together instead of doing that manually.

Catherine: since we can combine filters, it should be possible?

[Cosmin goes to the filter dialog box and creates a new string filter to filter edges of name 2h (figure 44) ; it does not select any 
edge] 

Figure 44

Cosmin: [while playing with the attributes menu]  I don't know what it means for an edge "canonical name" ? [he then selects 
the interaction attribute]

Melissa: is 2h the full name?

[Cosmin then put '*' characters on both sides of the search string, which fails as well ; he then put the full name - same]

Melissa : let's select one specific edge and look at it in the edge attributes browser... [Cosmin selects the appropriate item in 
the menu to select an edge, and then displays the edge attribute menu in the bottom panel]

Cosmin: ah...! [he then selects the name displayed in the Extend Gene name column and tries the filter ; this time it worked - 
figure 45]
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Cosmin: Probably it should be that ... Could it be that if I'm not in a mode which allows edge selction, thne it won't work? 
[Cosmin tries this..] Oh, I cannot deselect? [he looks at the Select->Edges menu and finds the "Deselect all the edges" item and 
then re-apply the filter]. Ok, it works, good point.

Catherine: I would have many more questions!! I would have a question about how do you share in the group?

Cosmin: we share the preferences file.

Catherine: if you want to explore, to try visual attributes.. do you have your own personal files?

Cosmin: we try to have a kind of graphic chart. We need to agree that yellow is etc... 

Catherine: do you have local datasets?

Cosmin: We have a Web interface where you can ask for a SIF file. Normally we have one SIF file.


